Using Microsoft Word 2010 Styles and Contents
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@ Using Microsoft Word

Styles and Contents

Styles enable a user of Word to create ‘sets’ of formatting that can be used
repeatedly throughout a document. For instance, if you wanted to make sure all of
the headings in your document appeared the same way, you could create a style with all the
necessary formatting and apply that style to each of your headings, which would be a lot quicker
than individually formatting each one. Additionally, once a style has been used in a document,
changing the formatting for that style will change any parts of the document that use that style.
This makes it possible to modify the formatting of several sections all at once. In short, when
you use a style, you can use several formats in one simple step.

You can create:

o A character style — to control formats on text within a paragraph such as fonts, sizes and
colours.

o A paragraph style — to control paragraph formats such as alignment, tabs and spacing.
They can also include character formats.

o A table style — to provide consistent borders, spacing, shading and fonts in tables.

o A list style — to quickly format numbering or bullet characteristics for lists.

Using styles in a document not only simplifies formatting and helps to keep formatting
consistent within a document, it can also be used to assist in the generation of special Word
objects such as document Indexes and Tables of Contents.
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Using Built In Styles

When a new document is created in Word, it will have a few styles included by default.
Standard text uses a style called Normal. It formats text with Calibri font with 11 point size
some extra space between paragraphs and lines. Like any style, the Normal style can be
modified. A new document will also include some default fonts for use as headings. These styles
can be selected in a number of ways as shown in the following exercise.

Exercise 1. Applying Standard Styles

1) Open the Word document called Cottage Pie Recipes. All of the text in the document is
currently formatted using the Normal style. You can tell since no matter where you are in the
document, the styles selection in the ribbon will show the name of the style for the text your
insertion point is currently in.

AaBbCecl AaBb( | AaBbCcl | AaBbCel aAaBbCcI AaBb( ;
Emphasis Heading 1 T Mormal Strong Subtitle Title -

Styles

2) Click anywhere in the line at the top which says Cottage Pie Recipes.

3) Move your mouse over the styles shown. Notice that
the name of each style is shown using a sample of the = 4aBbCel AaBb(  AaBbCcl
style’s formatting. If you leave your mouse over one of = Emphasis ~ Headsfig1 | 7 Hormal
the styles, your selected paragraph will change to show
you how it would look with that style.

4) Click on Heading 1 to apply that built in style. Because it is a paragraph style, the whole line
will be formatted without the need to select it all.

Some of the built in styles may also be selected using certain keyboard shortcuts.

5) Click on the next line where it says Cottage Pie recipe from British Food. We will format
this using the Heading 2 style.

When you have normal text selected (l.e. when you are not in a list) you can use keyboard
shortcuts to change the selected paragraph to one of the built in heading styles. The [Alt] [Shift]
[ shortcut will change to the next heading style while the [Alt] [Shift] [¢] shortcut will change to
the previous heading style as you will soon see.

6) Hold down [Alt] and [Shift] and then press the left arrow key [€]. The paragraph will now be
formatted using the Heading 1 style. We want this paragraph to be formatted using the next
available style which is Heading 2.

7) Hold down [Alf] and [Shift] and then press the right arrow key [2]. The paragraph will now
use the Heading 2 style. Heading 2 should be displayed in the Styles box on the toolbar.

Note When you are in a list, these same shortcuts may be used to adjust indentation and
promote/demote list items.

Tip With normal text selected, the [Alt] [Shift] [€] shortcut will apply the heading style last used. The
[Alt] [Shift] [>] will apply the Heading level below the one last used.
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Using the Styles and Formatting Task Pane

So far you will have used the task pane for tasks such as working
with clipart and mail merges. It can also come in handy when you
are working with styles.

You can also easily display the styles task pane by clicking the
small Styles icon in the corner of the Home ribbon group.

Exercise 2. Applying Styles
1) Click in the paragraph which contains the single word Source.

Styles and Contents

AaBbCcl  _ %

— | Change
T | Styles ~

=k

thCc]

ulglsl Subtitle

2) Click the Styles icon in the corner of the Home ribbon group
. The task pane should appear as shown to the right. With
the task pane visible you can see a complete list of styles
that are being used in a document and select styles from the
list by clicking on them. The task pane also makes several
other important options available as shown later.
Click on the Heading 3 style in the list to apply that style to
the selected text. Repeat to apply the heading 3 style to the
lines which say Ingredients and Method.
Time to practice. Continue through the rest of the
document and use any of the methods you have tried so far

3)

4)

-

Styles

Clear all +
| Bold |

Bulleted, Symbal (symbael), Le

Heading 1

Heading 2

Hyperlink

e I i )

Maormal

Mumbered, Left: 0 cm, Hangi

to format the remaining headings. All of the recipe names

(E.g. Comforting cottage pie and Proper English Cottage Pie) should be formatted using the
Heading 2 style. All of the headings which say Source, Ingredients and Method should be

formatted using the Heading 3 style.
5)
formatted. As in the example below.

Save the changes to the document when all of the headings have been appropriately

Townies Cottage Pie

Source
httpfithefoody comimeat/townie scottagepie. html

Ingredients

450g (1) Minced Beef
675g (13:1b) Mashed Potate
1 Onien

1 Catrot

1 tin Mushroom Soup

110g (4oz) Peas

2 Cloves Garlic

50g (2oz) Cheddar Cheese
Zalt and Black Pepper

Method

Fre-heat the ovento 120°C; 375°F: Gas 5
Chop the onion and carrot

PEPPET.
Idix the meat, vegetables and soup place in a ceramic dish,
Cover the mixture with an even layer of mashed potato.
Cover and bake for 30 - 40 minutes.

Fry minced beef until lightly coloured and remowve from the pan and drain well.
Add the onton, garlic and carrot cocking gently until the onton 13 transparent and

Note Applying a style may replace existing formatting.
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Modifying Styles

When you change a style’s attributes, any part of your document which that style has been
applied to will update to take on the changed attributes of the style. Styles can be changed by
editing the options for a style. They can also be changed by formatting a section of your
document the way you want the style to look, selecting it and then changing the style to match
what is selected.

Exercise 3. Updating Style Definitions |E|| [ Feading 1 )
1) Make sure the Styles task pane is showing on the Update Heading 1 to Match Selection
side of your screen. :
: Modify...
2) Move your mouse over the Heading 1 style and ¥ Mod
click on the drop down arrow which appears. A Select All1 Instance(s) |
style menu will be displayed. Clear Formatting of 1 Instance(s)

Note the first option displays the number of instances Delete Heading 1

where the style is used and allows you to select each Remove from Quick Style Gallery
instance of that style. In this case, selecting this option

would select every paragraph where the Heading 1 style is used, though only one paragraph is
currently using it. You will also notice that the delete option is unavailable since Heading 1 is
one of the standard styles. You can only delete new styles that you have created. Deleting a style
will mean that any text using that style reverts back to using the Normal style.

3) From the style menu click the Modify option. The following dialog will appear.

[ Modify Style L2
Properties
Mame: Heading 1
Style type: Linked (paragraph and character
Style based on: 1 Mormal |E|
Style for following paragraph: | T Mormal |Z|

Formatting

Cambria I:Headings]E 22 |E| Vi | Automatic |E|

=B = (5)= = |2 2 = =
Cottage Pie Recipes
Font: (Default) +Headings (Cambria), 22 pt, Bold, Kern at 16 pt, Centered, Space -

Before: 12 pt
After: 3 pt, Keep with next, Level 1, Style: Linked, Quick Style
Based on: Mormal i

Add to Quick Style st [7] Automatically update
@ Only in this document () Mew documents based on this template

[ oK I[ Cancel ]

.
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4) Change the font size from 16 to 22 and change the alignment to centre. The options should
look the same as the example above.

5) Click OK to update the style definition. The first paragraph, which uses the Heading 1 style
will update to reflect the formatting changes. If other paragraphs used the same style then
they would also update.

Exercise 4. Updating Styles by Example

1) Select the first paragraph that uses the Heading 2 style (Cottage Pie recipe from British
Food).

2) Change the formatting of the paragraph so that it is a different colour, size sixteen and
remove the italic formatting.

If you look in the Styles and Formatting task bar, you will notice | Heading2 13
that the Heading 2 style is listed twice. The first one is for the style | Heading 2 + 16 pt, Not Italic, |
on its own. The second one is for instances of the style where | Heading 2 L

additional formatting has been applied.

3) Click on the arrow next to the main Heading 2 style (the one without the modifications).
4) From the style menu which appears, select Update T | Heading 2 E]A

Heading 2 to Match Selection. Update Heading 2 to Match Selection

The Heading 2 style will be changed to match the |y wodify..
selected text. The modified version of the style will

also disappear since that has now become the main
Style, Clear Formatting of 4 Instance(s)

Select All 4 Instance(s)

5) Scroll through the document to check that the rest Delete Heading 2
of the headings using the Heading 2 style have Remove from Quick Style Gallery
been updated with the formatting changes.
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Creating Styles

Like most tasks in Word, there is more than one way to create a new style. The following
exercises will demonstrate some of those methods. Note that styles you create can also be
deleted, but built in styles such as Heading 1 cannot be deleted.

Exercise 5. Creating a New Paragraph Style

1) Select the source for the first recipe. Your selected text should contain a web address.

2) Change the formatting to Arial, 10pt font size, 0.5cm indent and underlined. The text should
look like the example below.

Cottage Pie recipe from British Food

Source
http:/fwww_ britainexpress comfarticles/Food/cottage-pie_htrml

Ingredients
lIb Ground Beef

1 vrallnesr nmimm

3) Make sure the text you just formatted is still selected. Because we are going to create a
paragraph style it is not necessary to select the entire paragraph style. Selecting any part of
the paragraph or even just having your insertion point somewhere
within the paragraph is sufficient.

The style box on the ribbon will show the name of the currently
selected style. Currently you have selected text which is using the

AaBbCc AaBbCcl
Heading 3 T Mormal

Normal style in addition to some modifications. Styles

4) Click the icon ™ at the end of the styles section of the Ribbon. cI | AaBbCcl _

5) From the menu which appears, select Save Selection as a New Quick | strong = C
Style. ’

6) When the Create New Style from Formatting dialog appears, enter Sources
for the style name and click OK.

Create Mew Style from Formatting Ii'ﬁ

MName:

Sources

Paragraph style preview:

Style1

[ oK H Modify. . H Cancel ‘

L

Mormal T

Notice that the new style will now appear in the Styles pane. The
Mumbered, Left: 0 cm, Hangi

icons next to each style show you what type of style it is. For
example your new Sources style has a 12 icon which tells you it’s
a style which contains both paragraph and character formatting.

| sources 1a|
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7) Use the methods you have learned previously to apply the sources style to all of the other
website addresses in the document. Since it’s a style with paragraph formatting, you won’t
need to select a whole paragraph to apply the style

Cottage Pie Recipes

Cottage Pierecipe from British Food

Source
http:/fweww britainexpress. com/anticles/Food/cottage-pie. htm

Ingredients
11b Ground Beef

1 vellow onion

Vegetable Cube

Com-starch

A handful of peas (can be frozen)

6 large baking potatoes

Browning and seasoning sauce (I use Kitchen Bougquet)

Method

Peel and chop up the potatoes into large chunks and put on to boil in a pot. This will
take about 20 minutes. While the potatoes are cooking, vou can start cooking the
meat.

Chop up the onion and frv in a pan until almost golden brown. Add the ground beef
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Exercise 6. Creating a New Character Style

The styles box provides a quick way to create paragraph styles, but for other types of styles and
additional options, you can use the New Style dialog. We’re going to create a new paragraph
style that we will use to format key phrases in the recipes.

1) Click the New Style button at the bottom of the Styles and Formatting task pane.

Options...

A dialog box like the one shown below will appear.

Create New Style from Formatting I.ilﬂ_hj
Properties
Mame: Stylel
Style type: Paragraph

Style based on: 1 Mormal |E|
Style for following paragraph: T Stylel |E|

Formatting
Times Mew FRoman Izl 12 Izl B I U Automatic |E|

(]
il
(1]
If
[
Lk
Il lh
& o
Il lh
L]
]
Ihd
]

Sample Text Sampls Text Sampls Text Sampls Taxt Sampls Text Sampls Taxt Sample Taxt
Sample Text Sampls Text Sampls Text Sampls Text Sampls Text Sample Taxt Sample Taxt
Sample Taxt Sampls Taxt Sampls Taxt Sample Text Sample Text S3ample Taxt Sampls Taxt

Style: Quick Style
Based on: Mormal

Add to Quick Style list [ Automatically update
@ Only in this document () Mew documents based on this template

oK ] [ Cancel

The options are explained below.

Name Name of the new style
Style Type Choose from paragraph, character, list etc.
Style based on You can choose to use an existing style as the starting point for a new

style. If the original style is changed, any similar formatting in the new,
related style will also change. This option is not available if list style is
selected in style type.
Style for following You can specify a default style to follow the current style. For example, if
paragraph you are editing the Heading 1 style, you can use this to specify that when a
user presses [Enter], the next style will automatically be set to Heading 2.
This option only applies when the style type is set to paragraph.
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Formatting

quick access to formatting options.

Format

2)
3)
8)

For the style name enter Keywords.
Change the style type to Character.

We could use the few options available for specifying the format

for the style but we need more options so click the Format button.
Only the options that relate to Character styles are displayed. Click
Font to display the Font formatting dialog.

9)
ones shown below.

Change the font formatting options so that they are similar to the

Styles and Contents

These options will vary depending on the style type selected and provide

The format button provides access to advanced options such as the Font
formatting dialog and the Paragraph formatting dialog.
|

[RETT F

Font...

‘_u._..,._,..I:};_...I
Paragraph...
Tabs...
Border...
Language...
Frame...
MNumbering...
Shortcut key...
Text Effects...

Font

Font Advanced

Font:

Comic Sans M3

Font style:

Colonna MT

Consolas
Constantia
Cooper Black

Changed font and / |

font colour \

,/ Comic Sans MS

| |Reqgular e
— | |Italic

Ll |Bold

Bold Italic

-

W oo
/

N Font color:
N —
Effects
Strikethrough
Double strikethrough
Superscript
Subscript

Preview

Underline style:

Shadow
Qutline

[ Emboss
|:| Engrave

All caps
Hidden

Small caps

11pt font size

o Shadow effect

Comic Sans M5

Ok

] [ Cancel

10) Click OK to after the options are all set.
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11) Check that the style options look like the ones below and click OK to create the style.

Properties
Mame: Keywords
Style type: Character
Style based on: a Default Paragraph Font |E|

Style for following paragraph:

Farmatting

Comic Sans MS |E|11|E| B 7 U _E

Somple Text Somple Text Somple Text Somple Text Somple Text Somple Text Somple
Text Somple Text Somple Text Somple Text Somple Text Somple Text Sample Text
comple Text Somple Text Somple Text Somple Text Somple Text Somple Text Somple
Text Sample Text

Font: Comic Sans MS, 11 pt, Double underline, Underline color: Accent 2, Font color: Accent 3,

Shadow, Mot Emboss, Mot Engrave, Style: Quidk Style
Based on: Default Paragraph Font

Add to Quick Style list
@ Only in this document () Mew documents based on this template

[ QK ] [ Cancel

12) In the method section for the first recipe select the word Peel.

13) Apply the new Keywords style to that text
14) Continue through the document and apply the style to other words that may be key parts of

the recipe such as chop, fry and mix.

Method

Peel and chop up the potatoes into large chunks and put on to beil in a pot. This will
take about 20 minutes. While the potatoes are cooking, vou can start cooking the
meat.

Chopup the onion and fryin a pan until almost golden brown. Add the ground beef
and break it all up and cookuntil no longer red in colour. Turn on the oven and

preheat a deep baking dish in there.
Add the vegetable cube and make sure it is broken up and mixed in.

Throw in the peas - even if thev're frozen and mix them into the meat and continue to
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Exercise 7. Creating a List Style

1) Click the new style button.
2) Change the options as shown below.

Create Mew Style from Formatting Iilﬂ_hJ
Properties Ingredients for th
: style name
Mame: Ingredients
Style type: s - | || List for the style
Click the bullets icon to type
make it a bulleted list i .
ApplX formatting to: 1st level IZI
> [+l B 7 U |
= L2 -] @ & = =
1)
a)
1)
(1)
Indent: -
Left: Oacm W
Hanging: 0.53 cm, Outline numbered + Lewvel: 1 + Mumbering Style: 1, 2, 3, ... +Startat: 1+ —
Alignment: Left + Aligned at: 0 cm + Indent at: 0.63 cm e
i@ Only in this document () New documents based on this template
o) [ ]

3) Click on the Insert Symbol icon£2. A dialog box like the one below will appear.
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[ symbol L2 [
Font: Wingdings =
A< ia 2[5 ¢ 1B 0 1= el
O E|EIGE| 2 | &EE ez =EH®
=m|d|d|e|e=|=|d|P | T O OB LK
S KX P Y FA R Y P g P P P FA PV
TS| 8 (M| £ M| X | Yo 2| X |eri& ] @ | O |’
OQ0 ¢ | ¢ & < » XD B | “ 7|0
Recently used symbols:
= VO A ®a | & €L ¥EOC®™ML | £<
Wingdings: 38 Character code: |33 from: | Symbal (decmal) E
(o ] Lo |

4) From the list at the top choose a symbols font such as Wingdings and then select a symbol to

use for your bullets.

5) Alternatively you could click the Insert Picture icon 8 and then select a picture to use as a

bullet symbol.

6) When you are satisfied with your selection, click OK to complete the creation of the style.
7) Select the ingredients for the first recipe and apply the new Ingredients style.

Note If the style doesn’t appear in your main list of

styles, click the Multilevel List icon “i-~
ribbon. You will be able to select the new list style

from the menu which appears.

in your

List Styles
ca
a)

iy

8) Apply the style to the ingredients in the other recipes.

Source

Comforting cottage pie

httpfwww. bbc.co ukffoodirecipes/database/comfortingcottagepie 14505 shtml

Ingredients
(2 1 thsp oil

——

e

Y e

=< 1 large onion chopped
[H 2 medium carrots, chopped
L 560g/1% 1b beef mince
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Exercise 8. Style Sets

Word contains several sets of styles which are intended to work together to give your document
a consistent look. These style sets contain styles for common document elements such as

headings.

1) Scroll to the top of your document where you can see the main different types of headings in
use. _

2) Click the Change Styles icon. %

3) From the menu which appears select Style Set. A list of available style sets will Change
appear. ‘A Style Set g Styles -

4) Move your mouse over some of the available style sets. As you move your mouse over each
one, the styles in your document (such as heading styles and the normal style) will change to
show how they would look using that style set.

5) Select a style set that you like the look of and click on it to apply the set. If you’d rather keep

the styles you already have then simply click outside the list to close it.

| % #4 Find ~
AaBbCc | AcBbCcl AaBbCcel

Heading3 | Keywords TMormal | _ | |Shange
T || styles = || M Select =

a
wac Replace

Default (Black and White] A Style Set &’
Distinctive '
Elegant _A

—.# Paragraph Spacing »
Fangy —gt Faragraph >p q

5et as Default

Formal

FaINg 3 =]
Manuscript aerlink a
Modern mwords a
Mewsprint mal T

nbered, Left: 0 cm, Hangi
Perspective i

T

Gottaye Pie Recipes

Cottage Pie recipe from British Food

Source
http:ffwwew britainexpress. comfaricles/Food/cottage-pie. htm

Ingredients
Ld 1lb Ground Beef

Ed 1vyellow onion
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Exercise 9. Additional Practice

1) Click the arrow next to the Heading 2 style and select | | Heading 2 =
Modify. Update Heading 2 to Match Selection
%4 Modify...
[ | + Sl Temrt—m £el %

2) Click the Format button at the bottom of the styles options and select
Paragraph.

i Font...

Paragraph... I},

3) When the paragraph formatting options appear, click the Line and Page Breaks tab at the top.
Indents and Spacing | Line and Page Breaks [J}

4) Click the Page break before option. [ Page break before

5) Click OK to close the Paragraph formatting options.

6) Click OK again to close the style options and confirm the change. Each paragraph using the
Heading 2 style will now begin on a new page. Don’t worry about all of that blank space on
the first page. We’re about to make use of that.
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Tables of Contents and References

One of the most useful things about using heading styles in a document is that they can be used
to automatically create an index or a table of contents. These will use your style to create fields
complete with links and page numbers, which can be automatically updated when the document
changes.

Exercise 10. Creating atable of contents

1) Click on the blank line beneath the main heading on the first page. This is where our table of
contents will be placed.
2) Select the References tab on the Ribbon.

3) Click the Table of Contents icon on the left end of the ribbon. Table of
Contents -

Built-In
Automatic Table 1

A menu will appear showing a couple of Table of Contents
styles. Contents

Heading 3

Automatic Table 2

Table of Contents
Heading 1

Heading 3

Manual Table

Table of Contents
Type chaptor titls (level 1).............

Type chapter title (level 2).....

Type chapter title flevel 3}

[l More Table of Contents fram Office.com
E] InsertTable of Contents...

4) Select the &
The Index and Tables dialog will appear.

Insert Table of Contents... gption from the bottom of the menu.

Table of Contents @I&J
Print Preview Web Preview
Heading 1. 1= Heading 1 -
(1 (1
Heading 2 ..oonenecreininnnns 3 Heading 2
Heading 3...covveeernnnnininnnns 5 Heading 3
Show page numbers IUse hyperlinks instead of page numbers
Right align page numbers
Tab leader: |....... IZ|
General
Formats: From template E|
Show levels: |3 :
[ Options... ] [ Maodify. .. l
[ Ok l [ Cancel ]
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5) View the different Formats options and see the result in the |%en=a!
Print Preview box. Select a format that you like the look of. | Formats: E
6) Click the Options button. -

Show levels: |3 =

Table of Contents Options

Available styles:

Caption
¥  Heading 1
¥  Heading 2
¥  Heading 3

Heading 4

Heading 5

Qutline levels
[] Table entry fields

Build table of contents from:

These options allow you to specify which styles will be included in the table of contents and
what level they will be. The first three headings are selected by default. You can add additional
paragraph styles to be included but we’ll leave them as they are for now.

7) Click Cancel to return to the main Index and Tables options.
8) Click OK to complete the table of contents.

A table of contents is automatically generated from the paragraphs in your document that are

using the heading styles.

Cottage Pie Recipes

Gottage Pie Recipes

Source

Cottage Pie recipe from British Food

Ingredients

Method

[T S R R 8

source

Comforting cottage pie

Ingredients

Methaod

[T FL I LR A ¥ ]

Source

Proper English Cottage Pie

Ingredients

Method

LS R B ¥ ¥ ]

Townies Cottage Pie

source

|
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The table of contents is a field, just like page numbers in footers or totals in a table. This means
that it can update when there are changes to the document information that it is based on. If you
make changes to your document and want to update the table to reflect the changes, you can
update the field.

9) Right-click inside the table and select Update Field (or click inside the field and press the [F9]
key which does the same thing). The following options will appear.

Update Table of Contents I.ili_hj

Ward is updating the table of contents. Select one of
the following options:

@ ipdate page numbers only’
Update entire table

10) The first option will only update the page numbers without changing any of the items in the
table of contents. The second option updates page numbers and will also check the document
for additional headings to add to the table of contents and deleted headings to remove from
the table of contents.

Note When you have a table if contents or an index referring to page numbers, it makes sense to add
page numbers to each page using headers and footers as shown earlier. In this exercises we
haven’'t done that but if you can’t remember how, refer back to the earlier exercise titled
Paragraph Formatting.

Tip If you move your mouse over the table you will see a message like the
one to the right. Holding down [Ctr]] and clicking on an item in the
contents will take you to the part of the document that the item refers to.

Current Document
Ctrl+Click to follow link
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Exercise 11. Using the Navigation Pane

When you start Word, the Navigation pane will usually be visible on the left side of your
document. This provides you not only with useful tools for navigating your document. It also
provides some useful tools for changing the structure of your document. Ruler

1) If you have closed the Navigation Pane, click the View tab on the Ribbon.

[ Gridlines
2) From the Show section of the ribbon, click the Navigation Pane option to o
el - Mavigation Pane
make sure it is ticked.
Show
The Navigation Pane should be visible to the left of your document.

- Y
@’ = (L T @ |= Cottage_Pie_Recipes.doc [Compatibility Mode] - Microsoft Word non-commercial use l‘:'l—EIIéJ
Home Insert Page Layout References Mailings Review View Developer Add-Ins Acrobat ) e

J _|:J B Web Layout Ruler (9] 9 [Elone Page = Mew Window 1] View Side by Side % ==
= outline [ Gridlines N L 0 [0 Two Pages | = Arrange All =2
Print |Full Screen Zoom  100% Switch Macros
layout | Reading (= Draft Mavigation Pane " 2l Page Width | [ split 4 Windows ~ -
Document Views Show Zoom Window Macros
Mavigation - X mil-l-|-R-|-1-|-2-|-E-|-4-|-E-|-5-|-_?-|-5-|-5-|-1:--|-11-I-12-I-1E-I-14-|/\15-I-16-I-1?F.‘_-.|
t ; ; ; ; ; ; g 7 ; ; ;
Search Document P &
rs
HE > | =
FY :—1
| Cottage Pie Recipes z
4 (Cpttage Pie recipe fro... |
Source N i _
Ingredients - Cottage Pie Recipes|
Method . Cottage Pie Recipes 1
4 Comforting cottage pie - Cottage Pie recipe from British Food 2
Source m Source 2
Ingredients = [~ Ingredients 2
-
Method ° Method z
4 Proper English Cottag... . Comforting cottage pie 3
i} Source 3
Source - X
- - Ingredients 3
Ingredients 5 Method 3
Method - . .
~ Proper English Cottage Pie 5 hd
4 Townies Cottage Pie = Source 5 £
Source = Ingredients 5 o
Ingredients N Method 5 &
R >l |4 | M | >
Page:1of7 | Words: 1,068 | & | Insert | IEEEEEREES U (&)
\

The Navigation Pane will show the paragraphs that have been formatted using heading styles.
3) Click on a heading within the Navigation Pane. You will be taken to that heading.
You can also use the Navigation Pane to rearrange sections of your document

4) In the Navigation Pane, move your mouse over Proper English Cottage Pie.
4 Proper English Cottag... -

o
™
Source

Iﬂgredieﬂ| Proper English Cottage Pie

Method

5) Drag that heading so that it is above Comforting Cottage Pie.
Method

4 Comfortin cottage pie
St:nurc;%:i
6) Not only will this change the order of the headings in your document, it will also change the
order of everything under those headings. It is an easy way to re-arrange entire sections
within a document.
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Exercise 12. Adding Internal References

There are times when it is useful to have a reference to another page in the document without
having to create an entire index or table of contents. There are two steps to doing this. The first
step is to create a bookmark at the location you want to refer to. The second step is to create a
reference that points to that bookmark.

1) Scroll to the end of the document and select the last word, which should be grill. &
2) From the Insert tab, click on the Bookmark icon.
Bookmark
[ Bocokmark I.ilﬁ
Bookmark name:
Grill Add

Sortby: @ Name

(7 Location

[] Hidden bookmarks

3) Under Bookmark name, type grill.

4) Click the Add button.

5) Click on the Bookmark icon again and you will see that the grill bookmark has now been
added. We will create a reference elsewhere using this bookmark as target.

6) Click Cancel to close the Bookmark dialog.

7) Scroll to the first recipe (Cottage Pie recipe from British Food).

8) Scroll to the last sentence and add the following text to the end of the paragraph (With 2
spaces instead of one between the words page and also).

The Townies Cottage Pie on page also grills the pie.
9) Format the text in italics.

10) Place the insertion point between the words page and also.
11) Select the References tab and click on the ! Cross-reference joon,
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Styles and Contents

-

Cross-reference

A=

Reference type:
y | Bookmark

DV

Select Bookmark /

as the reference
type

Insert as hyperlink
Separate numbers with
For which bookmark:

Gl . |§

Insert reference to:

] Errrr— |
[ tndude above/below \

Select Page number
under Insert
reference to

12) Since there is only one bookmark it will already be selected in the list. Click the Insert button

to place the reference in the page.
13) Click on Close to close the Cross-reference dialog.

Remove from grill and enjoy with some red cabbage and HP sauce (Steak sauce if you can't get

that). The Townies Cottage Pie on page 7 also grills the pie.

Note
the number up to date.
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If the page numbers in your document change, you can update the filed in the usual way to bring
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Exercise 13. Adding a Footnote

When a writer wants to support their text with a brief bit of additional information without
disrupting the flow of the text, a footnote may be used. Footnotes are easy to create in Word. *

1) In the ingredients for the first recipe, click at the end of the line which says, A handful of
peas (can be frozen).
2) From the References tab, click on the Insert Footnote icon.

Insert Page Layout References Mailings
[i] ﬁ :*nj Ma
AE Next Footnote ~ = 3 sty
Insert Insert )
Footnote &= Show Notes Citation ~ @b Bib
5 Footnotes ‘ Citations & Bi

A new footnote will be created at the bottom of the page just above the area where the footer
would be.

Remove from grill and enjoy with some red cabbage and HP sauce (Steak sauceif you can't get
that). The Townies Cottage Pie on page 7 also grills the pie.

|
3) Type the following text.

Other vegetables may also be added for variety

The footnote reference should now look like the example below.

Ed Corn-starch
Ed A handful of peas (can be frozen)!

2 6 large baking potatoes

The footnote text at the bottom of the page should look like the example below.

Remowve from grill and enjoy with some red cabbage and HP sauce (Steak sauceif you can't get
that). The Townies Cottage Pie on page 7 also grills the pie.

! Other vegetables may also be added forvariety

4) Save and close the document.

! This is an example of a footnote
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